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NI VirtualBench™ Help 

January 2017, 371526G-01 

This help file contains information about using the NI VirtualBench all-in-one 
instrument. 
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Connecting to VirtualBench Using USB 

1. Plug in the power cable. 
2. Connect the VirtualBench hardware to your computer using the USB cable. 
3. The VirtualBench application starts automatically after 60 to 90 seconds. If the 

VirtualBench application does not start, refer to Why Doesn't the VirtualBench 
Application Start Automatically?. 

Related information 

What Are the Different Ways to Run the VirtualBench Application? 
How Do I Install the VirtualBench Application? 
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Connecting to VirtualBench Using Wireless 

You can establish a wireless connection to VirtualBench by configuring it as an access 
point, or by connecting VirtualBench to your wireless network. By default VirtualBench 
powers up in access point (AP) mode. 

Connecting to VirtualBench as an Access Point 

Connecting to VirtualBench Using an Existing Wireless Network 

Connecting to VirtualBench as an Access Point 

By default VirtualBench powers up in access point (AP) mode. Your computer must 
have wireless networking capability to establish a wireless connection. 

1. Install the VirtualBench application on your computer. 
2. Connect the antenna. 
3. Plug in the power cable. 
4. Connect the VirtualBench hardware to your computer using the USB cable. 

The VirtualBench application should start automatically. If it does not, refer to Why 
Doesn't the VirtualBench Application Start Automatically?. 

5. In the application, create a new wireless network. 
1. Click the wireless icon to open Network Configuration. 
2. Select Create new wireless network. 
3. Fill in a Network Name, Channel, and Security. 
4. Click Apply. 

6. Close the VirtualBench application. 
7. Open your computer's network settings and connect to the VirtualBench device. 
8. Disconnect the USB cable. 
9. Launch the VirtualBench application from your Start menu. Click Search for 

Device. The VirtualBench should be listed in the Select a device window. 
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If you are still having trouble connecting to the VirtualBench hardware, try the 
following tips: 

• Reset VirtualBench to the factory default mode. 
1. Close the VirtualBench application. 
2. Press and hold the reset button for five seconds or longer. 

After rebooting the device will default to VB80xx-<serial number> as the 
access point name. Refer to Reset Button for additional information. 

3. Open your computer's network settings and connect, or verify your 
connection, to the VirtualBench device. 

4. Launch the VirtualBench application from your Start menu. Click Search for 
Device. The VirtualBench should be listed in the Select a device window. 

• Disable your computer's firewall to make sure the firewall is not blocking the 
connection, or make sure your firewall settings allow for the network ports listed in 
the NI VirtualBench Specifications. 

• Disable any virtual machine network adapters such as VMWare. These adapters 
can route traffic incorrectly and cause the VirtualBench to not be discovered or 
used. 

• Verify that the antenna is connected. 

Related information Related information 

Why Doesn't the VirtualBench Application Start Automatically? How Do I Install the 
VirtualBench Application? What Are the Different Ways to Run the VirtualBench 
Application? Reset Button Wireless LED 

Connecting to VirtualBench Using an Existing Wireless 
Network 

Your computer must have wireless networking capability to establish a wireless 
connection. 

1. Install the VirtualBench application on your computer. 
2. Connect the antenna. 
3. Plug in the power cable. 
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4. Connect the VirtualBench hardware to your computer using the USB cable. 

The VirtualBench application should start automatically. If it does not, refer to Why 
Doesn't the VirtualBench Application Start Automatically?. 

5. In the application, connect VirtualBench to an existing wireless network. 
1. Click the wireless icon to open Network Configuration. 
2. Select Connect to existing wireless network and choose your preferred 

wireless network from the list. Some networks require a network security key 
or passphrase. Enter one if prompted. 

3. Click Apply. 
6. Connect your computer to the same wireless network as the VirtualBench. 

1. In Windows, open Connect to Network by clicking on the network icon in the 
notification area. 

2. In the list of available networks, select the same network that you connected 
VirtualBench to. Click Connect. 

You must connect your computer to the same wireless network as the 
VirtualBench. 

7. Disconnect the USB cable. 
8. Launch the VirtualBench application from your Start menu. Click Search for 

Device. The VirtualBench should be listed in the Select a device window. 

If you are still having trouble connecting to VirtualBench, try the following: 

• Disable your computer's firewall to make sure the firewall is not blocking the 
connection, or make sure your firewall settings allow for the network ports listed in 
the NI VirtualBench Specifications. 

• Disable any virtual machine network adapters such as VMWare. These adapters 
can route traffic incorrectly and cause the VirtualBench to not be discovered or 
used. 

• Verify that the antenna is connected. 

Related information Related information 

What Are the Different Ways to Run the VirtualBench Application? Why Doesn't the 
VirtualBench Application Start Automatically? How Do I Install the VirtualBench 
Application? Reset Button Wireless LED 
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Connecting to VirtualBench Using Ethernet 

Some models of VirtualBench hardware feature an Ethernet port as an additional 
connectivity option. 

1. Install the VirtualBench application on your computer. 
2. Plug in the power cable. 
3. Connect the VirtualBench hardware to an Ethernet network or your computer 

using a shielded straight through Category 5 Ethernet cable. The Ethernet 
Connectivity LED turns on. 

Note  You can use a shielded straight through Category 5 Ethernet cable or an Ethernet 
crossover cable to connect the VirtualBench to your computer. 

4. Open the VirtualBench application on your computer. 
5. Click Search for Device. 
6. Select the VirtualBench device and click the Use This Device button. 

If you are having trouble connecting to the VirtualBench hardware, try the following 
tips: 

• Confirm that the Ethernet Connectivity LED on the front panel is lit, and the 10/
100/1000 and LINK/ACT LEDs on the Ethernet connector on the back panel are lit. 

• Ensure that the version of the VirtualBench application installed on your computer 
supports your VirtualBench. Refer to the What is the Earliest Supported Version of 
the VirtualBench Application for My VirtualBench? topic for the software version to 
install on your computer. 

• If you cannot see your VirtualBench automatically in the VirtualBench application, 
this may be because it is on your network but on a different subnet. You can find 
your VirtualBench by clicking Search for Device and then directly typing the IPv4 
address or the VirtualBench name in the Add network device field. The default 
host name of VirtualBench is VB80xx-<serial number>. 

• VirtualBench can also be accessed through a web browser. Type the host name or 
IPv4 address of the VirtualBench in your web browser. The NI Network Browser, 
which can show you all the NI configurable hardware on your local subnet, can 
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also be accessed by going to Start»All Programs»National Instruments»NI 
Network Browser. The device can be accessed through the web on a host PC that 
does not have any NI software installed. 

• IPv4 configuration can be set to automatically assign via the DHCP server on the 
host PC. Manually/statically setting the IPv4 address for the host computer may 
potentially put the VirtualBench on a separate subnet and therefore make it 
undiscoverable. Microsoft's web site explains how to change the IPv4 configuration 
in Windows; search for information about changing TCP/IP settings for your 
Windows version. 

• If connecting VirtualBench directly to a host PC, make sure that the computer is 
either running a DHCP server or the network card is set to obtain an IP address 
automatically. VirtualBench always looks for a DHCP server first and if one is not 
available, it will default to a link local IP address. Link local IPv4 addresses are in 
the following range: 169.254.1.0 to 169.254.254.255 with the subnet 
mask 255.255.0.0. Setting your computer to have a static IP address, 169.25
4.X.X, with the subnet mask 255.255.0.0 will ensure that the device and your 
computer are on the same subnet. 

• Connect the VirtualBench hardware to your computer using the USB cable. The 
VirtualBench application should start automatically. If it does not, refer to Why 
Doesn't the VirtualBench Application Start Automatically?. In the application, click 
the wireless icon and select Ethernet. View the network details by selecting 
Automatic configuration or change the network configuration by selecting Manual 
configuration and then enter configuration setttings. Click Apply. Close the 
VirtualBench application and open your computer's network settings and connect 
to the VirtualBench device. Then disconnect the USB cable and launch the 
VirtualBench application from your Start menu. Click Search for Device. The 
VirtualBench should be listed in the Select a device window. 

• Disable your computer's firewall to make sure the firewall is not blocking the 
connection, or make sure your firewall settings allow for the network ports listed in 
the NI VirtualBench Specifications. 

• If using a proxy server, add the address of the VirtualBench to the list of exceptions. 
This setting can be found in Internet Options. 

• Try disabling any antivirus software, it may be interfering with the discovery or 
configuration process. 

• Disable any virtual machine network adapters such as VMware. These adapters can 
route traffic incorrectly and cause VirtualBench to not be discovered or used. 

• If working through the previous tips do not result in finding your VirtualBench, 
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reboot VirtualBench by pressing the reset button as described in the Reset Button 
topic. 

Related information Related information 

Ethernet LEDs Reset Button What is the Earliest Supported Version of the VirtualBench 
Application for My VirtualBench? 
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Front Panel Pinouts and Connections 

1  Power Button and Power LED   6  Digital Multimeter (DMM)  

2  Digital I/O   7  Function Generator (FGEN)  

3  Wireless LED   8  External Trigger (TRIG)  

4  DC Power Supply   9  Ethernet and USB Connectivity LEDs  

5  Mixed Signal Oscilloscope (MSO)    
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Power Button and Power LED Power Button and Power LED 

Refer to the Power Button and Power LED topic for information about using this button 
to enter and exit standby mode and understand Power LED behavior. 

Wireless LED Wireless LED 

Refer to the Wireless LED topic for information about the behavior of the bi-color 
wireless LED indicator. 

Ethernet and USB Connectivity LEDs Ethernet and USB Connectivity LEDs 

Some models of VirtualBench also have connectivity LEDs for USB and Ethernet, 
indicating that a cable is plugged into a port on VirtualBench and a computer, hub, or 
network port. 

Mixed Signal Oscilloscope (MSO) Mixed Signal Oscilloscope (MSO) 

Refer to the Mixed Signal Oscilloscope Pinouts and Connections topic for pinouts and 
signal descriptions of the oscilloscope and logic analyzer. 

Function Generator (FGEN) Function Generator (FGEN) 

The FGEN BNC connector is the analog waveform output terminal from which standard 
functions and arbitrary waveforms are generated. The maximum output levels from 
this connector depend on the type of load termination. 

Caution  Exceeding the maximum output ratings, which are listed in the NI VirtualBench 
Specifications document, can damage the device and the computer. National Instruments 
is not liable for any damage resulting from such signal connections. 

Refer to the FGEN LED topic for information about the FGEN LED on some models of 
VirtualBench. 
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External Trigger (TRIG) External Trigger (TRIG) 

The TRIG BNC connector provides an additional trigger input/output source. Any of the 
digital I/O signals can also act as trigger inputs or outputs. Refer to the What Can I Do 
with the Digital I/O? for information about trigger signals on the digital I/O connector. 

Caution  Exceeding the maximum input voltage ratings or maximum output ratings, which 
are listed in the NI VirtualBench Specifications document, can damage the device and 
the computer. National Instruments is not liable for any damage resulting from such signal 
connections. 

Digital I/O Digital I/O 

Refer to the Digital I/O Pinout and Connections topic for the digital I/O pinout and 
signal descriptions. 

DC Power Supply DC Power Supply 

Refer to the VB-8012 DC Power Supply Connections and LEDs or VB-8034/8054 DC 
Power Supply Connections and LEDs topic for a pinout of DC power supply 
connections and behavioral information of the LEDs on your VirtualBench. 

Digital Multimeter (DMM) Digital Multimeter (DMM) 

Refer to the Digital Multimeter Pinout and Connections topic for information about the 
different connections you can make to the DMM. 

Power Button and Power LED 

VirtualBench features a power button on the front panel of the device that puts the 
device in and out of standby mode. Standby mode is a low power mode that can also 
be used as an "emergency stop"—to disable any outputs on VirtualBench. 

To put VirtualBench in standby mode, press the power button. In standby mode: 

• The light on the button turns off indicating that the outputs have been disabled. 
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• VirtualBench is no longer accessible through USB or wireless. 
• VirtualBench is no longer accessible through software. 
• All VirtualBench instrument outputs are disabled. 
• The DC power supply is disabled. 
• The digital I/O signals change to inputs. 
• The function generator (FGEN) changes to DC 0 V 
• The fan may spin occasionally to keep the VirtualBench within its calibrated 

temperature range. 

Note  VirtualBench automatically enters standby mode if the internal temperature of the 
processor exceeds 96 °C. When this happens, the fan works at full capacity until the 
device has cooled sufficiently. In this situation, standby mode can not be overridden by 
pressing the power button. 

To exit standby mode, press the power button again. The Power LED turns on and the 
VirtualBench is accessible over both the wireless network and USB. 

When exiting standby mode, you must re-enable the instruments, either through the 
VirtualBench application or LabVIEW. The VirtualBench instruments do not 
automatically resume their previous state. 

Power LED Patterns 

Pattern Description 

On Operating normally 

Off VirtualBench is in standby mode  

Blinking Hardware issue 

Related information 

Why Is the Power LED Blinking? 
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Wireless LED 

Bi-Color Wireless LED Patterns 

Color Pattern Description 

Orange On Wireless access available in AP mode (default startup mode). 

Blue 
Blinking Device trying to establish wireless connection in client mode. 

On Wireless connection established in client mode. 

— Off Wireless disabled. 

Mixed Signal Oscilloscope Pinouts and Connections 

Caution  Exceeding the maximum input voltage ratings, which are listed in the NI 
VirtualBench Specifications document, can damage the device and the computer. 
National Instruments is not liable for any damage resulting from such signal connections. 

Mixed Signal Oscilloscope Connections 

Logic Analyzer Cable Wire List 

Pin Signal Wire Color Pin Signal Wire Color 

1 GND Black 2 GND Black 

3 D16 Yellow 4 D0 Red 
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5 D17 Yellow 6 D1 Red 

7 D18 Yellow 8 D2 Red 

9 D19 Yellow 10 D3 Red 

11 D20 Yellow 12 D4 Red 

13 D21 Yellow 14 D5 Red 

15 D22 Yellow 16 D6 Red 

17 D23 Yellow 18 D7 Red 

19 GND Black 20 GND Black 

21 D24 Green 22 D8 Blue 

23 D25 Green 24 D9 Blue 

25 D26 Green 26 D10 Blue 

27 D27 Green 28 D11 Blue 

29 D28 Green 30 D12 Blue 

31 D29 Green 32 D13 Blue 

33 D30 Green 34 D14 Blue 

35 D31 Green 36 D15 Blue 

37 GND Black 38 GND Black 

39 CLK1 White 40 CLK0 White 

Mixed Signal Oscilloscope and Logic Analyzer Signal Descriptions 

Pin Connector Description 

CH <1..4> Standard BNC 
connector Analog input connection; digitizes data and triggers acquisitions 

Probe 
compensation 
tab 

Probe compensation output; oscilloscope compensation square wave 
used to tune the probe to minimize over/undershoot 

Probe compensation/oscilloscope ground 

D<0..31>  Logic analyzer 

Digital input signals 0 to 31. Grouped into four ports of eight lines: 

• Port 0 (D0..7) 
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• Port 1 (D8..15) 
• Port 2 (D16..23) 
• Port 3 (D24..31) 

CLK0 State mode clock 0 

CLK1 State mode clock 1 

GND Ground for digital signals 

FGEN LED 

(VB-8034/8054) The blue FGEN LED is located on the front panel above the FGEN 
connector. 

FGEN LED Patterns 

Pattern Description 

On FGEN is generating a standard or arbitrary waveform 

Off FGEN is off or not generating an output 

Blinking Warning that voltage is being applied/backdriven to the FGEN  

Note  VB-8012 does not have an FGEN LED; if the VB-8012 power button is blinking, the reason 
could be a warning that voltage is being applied/backdriven to the FGEN. 

Digital I/O Pinout and Connections 

Caution  Exceeding the maximum input voltage ratings or maximum output ratings, which 
are listed in the NI VirtualBench Specifications document, can damage the device and 
the computer. National Instruments is not liable for any damage resulting from such signal 
connections. 

Digital I/O Pinout 
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Digital I/O Signal Descriptions 

Signal 
Name Direction Description 

— Ground—The reference point for the digital signals and +3.3 V supply at 
the I/O connector. 

+3.3V Output +3.3 V Power Source—Provides +3.3 V power output up to 20 mA. 

dig/<0..7> Input or 
Output Digital I/O Channels 0 to 7. User selectable functions. 

Caution  Never connect the +3.3 V power terminal to analog or digital ground or to any other 
voltage source on VirtualBench or any other device. Doing so can damage the device and the 
computer. NI is not liable for damage resulting from such a connection. 

Related information 

What Can I Do with the Digital I/O? 

 

VB-8012 DC Power Supply Connections and LEDs 

Caution  Exceeding the maximum output ratings, which are listed in the NI VirtualBench 
VB-8012 Specifications document, can damage the device and the computer. National 
Instruments is not liable for any damage resulting from such signal connections. 

The DC power supply has three LEDs that correlate to the three available voltages 
available on the connector. 

Connections and LEDs 
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1  Channel +6V (0 to +6 V) and +6V LED   4  Common Floating GND  

2  GND   5  Common Floating GND  

3  Channel +25V (0 to +25 V) and +25V LED   6  Channel -25V (0 to -25 V) and -25V LED  

Note  The +25 V and -25 V channels are bank isolated from ground but not from each other. 

LED Patterns 

 LED  Color Description 

+6V 
Blue Constant 0 to +6 V voltage 

Orange   Constant 0 to 1 A current 

+25V 
Blue Constant 0 to +25 V voltage 

Orange Constant 0 to 500 mA current 

-25V 
Blue Constant 0 to -25 V voltage 

Orange Constant 0 to 500 mA current  

Note  The color of the LED matches the color of the CV and CC indicators in the VirtualBench 
application, blue and orange respectively. 

VirtualBench has three, single-quadrant DC power supply channels. Each channel on 
the DC power supply can operate only within one quadrant (channels +6V and +25V 
operate only within Quadrant I, and channel -25V operates only within Quadrant III). 

 DC Power Supply Channel  Quadrant Operation 
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+6 V, +1 A 

+25 V, +500 mA 
-25 V, -500 mA 

 

Related Information 

What Do CV and CC Indicate in the VirtualBench Application? 

VB-8034/8054 DC Power Supply Connections and LEDs 

Caution  Exceeding the maximum output ratings, which are listed in the NI VirtualBench 
Specifications, can damage the device and the computer. National Instruments is not liable 
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for any damage resulting from such signal connections. 

The DC power supply has six LEDs that correlate to the three available voltages 
available on the connector. 

Connections and LEDs 

1  +6V CV and CC LEDs   6  Channel +25V (0 to +25 V)  

2  Channel +6V (0 to +6 V) 7  Common Floating GND  

3  GND 8  -25V CV and CC LEDs 

4  GND 9  Channel -25V (0 to -25 V)  

5  +25V CV and CC LEDs  

Note  The +25 V and -25 V channels are bank isolated from ground but not from each other. 

LED Patterns 

 LED  Color Description 

+6 CV Blue Constant 0 to +6 V voltage 

+6 CC Orange   Constant 0 to 3 A current 

+25 CV Blue Constant 0 to +25 V voltage 

+25 CC Orange Constant 0 to 1 A current 

-25 CV Blue Constant 0 to -25 V voltage 

-25 CC Orange Constant 0 to 1 A current  
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Note  The color of the LED matches the color of the CV and CC indicators in the VirtualBench 
application, blue and orange respectively. 

VirtualBench has three, single-quadrant DC power supply channels. Each channel on 
the DC power supply can operate only within one quadrant (channels +6V and +25V 
operate only within Quadrant I, and channel -25V operates only within Quadrant III). 

 DC Power Supply Channel  Quadrant Operation 

+6 V, +3 A 

+25 V, +1 A 
-25 V, -1 A 

 

Related Information 

VirtualBench User Manual

© National Instruments 25



What Do CV and CC Indicate in the VirtualBench Application? 

Digital Multimeter Pinout and Connections 

Caution  Exceeding the maximum input voltage ratings, which are listed in the NI 
VirtualBench Specifications document, can damage the device and the computer. 
National Instruments is not liable for any damage resulting from such signal connections. 

DMM Signal Connections 

Measurement Wiring Diagram Range 

DC Voltage 100 mV, 1 V, 10 V, 100 V, 300 V 

AC Voltage 100 mVrms, 1 Vrms, 10 Vrms, 100 Vrms, 
265 Vrms 

DC Current ≤100 mA 10 mA, 100 mA 

DC Current >100 mA to 10 
A 1A, 10 A 

AC Current ≤50 mArms 5 mArms, 50 mArms 
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AC Current 500 mArms to 
5 Arms 500 mArms, 5 Arms 

2-Wire Resistance 100 Ω, 1 kΩ, 10 kΩ, 100 kΩ, 1 MΩ, 10 
MΩ, 100 MΩ 

Voltage Across a Diode 2 V 

Note  If the Digital Multimeter (DMM) always reads about 0.00 A or 0.00 mA when measuring 
current, the cause may be a blown fuse. 

Related information 

How Do I Test a Fuse? How Do I Replace a Fuse? 
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Back Panel Features 

1  Antenna   5  Chassis Ground Screw  

2  Reset Button   6  Power Connector  

3  USB Port   7  Ethernet Port and LEDs  

4  Security Cable Slot  
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Antenna Antenna 

Refer to the NI VirtualBench Specifications for information about the antenna on 
VirtualBench. 

Reset Button Reset Button 

Refer to the Reset Button topic for information about using this button. 

USB Port USB Port 

Refer to the NI VirtualBench Specifications for information about the USB port on 
VirtualBench. 

(Optional) You can provide strain relief for the USB cable by using the jackscrew on a 
locking USB cable (NI part number 198506-01) to securely attach the cable to the 
chassis. 

Ethernet Port and LEDs Ethernet Port and LEDs 

Refer to the NI VirtualBench Specifications for information about the Ethernet 
port on some models of VirtualBench. 

Refer to the Ethernet LEDs topic for information about the 10/100/1000 and LINK/ACT 
LEDs on the Ethernet connector. 

Security Cable Slot Security Cable Slot 

The security cable slot allows you to attach an optional laptop lock to your 
VirtualBench. The security cable slot might not be compatible with all laptop lock 
cables. 

Note  The security cable is designed to act as a deterrent, but might not prevent the device 
from being mishandled or stolen. For more information, refer to the documentation that 
accompanied the security cable. 
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Chassis Ground Screw Chassis Ground Screw 

The chassis ground screw provides an additional access point to chassis ground for 
measurement accuracy so that all instruments are at the same potential. 

Power Connector Power Connector 

Refer to the Power Requirements section in the NI VirtualBench 
Specifications for information about the power connector on VirtualBench. 

Reset Button 

The reset button is located on the back panel. Press and hold the reset button for five 
seconds or longer to reboot the device into factory default mode. 

VirtualBench Factory Default Mode Settings 

Attribute Value 

Network name VB80xx-<serial number> 

IP Given by DHCP 

NI Auth User name = admin, Password = leave blank 

During a reboot, saved configurations are deleted and the VirtualBench instruments 
reset to their factory default state. 

Ethernet LEDs 

Ethernet LED Patterns 

LED Color Pattern Description 

10/100/1000 
Yellow On Connected at 1000 Mbps 

Green On Connected at 100 Mbps 
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— Off No Ethernet connection or 10 Mbps connection 

LINK/ACT Green 

On Ethernet link 

Off No Ethernet connection 

Blinking Ethernet activity 
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Mixed Signal Oscilloscope (MSO) 

What Are Measurement Indicators? 

What Does the Auto Setup on the Mixed Signal Oscilloscope Do? 

What Sampling Modes Are Supported in VirtualBench? 

Does VirtualBench Support Interleaving? 

Does VirtualBench Support Interpolation? 

How Do I Use the Logic Analyzer? 

How Do I Use XY Time Mode? 

How Do I Verify That the Mixed Signal Oscilloscope Probe is Compensated Properly? 

What Are the Mixed Signal Oscilloscope Triggering Options on VirtualBench? 

What If the Data on My Graph or My MSO Measurement Is Not What I Expect? 

Why Can't I Sample at 1 GS/s with Two Channels (VB-8012)? 

What Is a Reference Channel? 

What Are Measurement Indicators? 

Measurement indicators visually show the point and/or regions used in deriving the 
numeric value shown in the Measurements panel below the graph. 

How Do I Show the Measurement Indicators? How Do I Show the Measurement Indicators? 

To show the measurement indicators associated with a measurement, follow these 
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steps: 

1. Select the desired measurement of an enabled channel by clicking on the 
measurement in the Measurement Settings window. The measurement is 
displayed in the Measurements panel. 

2. Click the measurement in the Measurements panel to highlight the measurement. 

The following image shows measurement indicators for a voltage amplitude 
measurement. The measurement is also highlighted in the Measurements panel below 
the graph. 

What Does the Auto Setup on the Mixed Signal Oscilloscope 
Do? 

When you perform auto setup, the mixed signal oscilloscope (MSO) senses the input 
signal and automatically chooses many of the instrument settings. 

If a signal is detected on an analog channel, the software chooses the smallest 
available vertical range that is larger than the signal range, and an offset to center the 
waveform within that range. For example, if the signal is a 1.2 Vpk-pk sine wave, the 
software will choose the 2 V vertical range for that channel. An analog channel is 
considered to have a signal present if the signal is at least 10% of the smallest vertical 
range available for that channel and vertical offset. 
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If a signal is detected on a digital channel, then the software enables that channel. 

If a signal is detected on at least one analog channel, then the lowest-numbered 
analog channel with a signal will be used as the Analog Edge trigger, and the sample 
rate and acquisition time will be optimized for that channel. 

If no signals are detected on analog channels but signals are detected on digital 
channels, then the digital channel with a signal with the fewest toggles will be used as 
a Digital Edge trigger, and the sample rate and acquisition time will be optimized for 
the digital channel with the most frequently toggling signal. 

If no signal is detected on any analog or digital channels, all settings configured by 
Auto Setup are placed in the default configuration. If you are using LabVIEW, a warning 
is also returned. 

Details Details 

The following settings may be changed during an auto setup: 

Analog Channels Analog Channels 

• Channel Enabled: Changed by Auto Setup 
• Vertical Coupling: Unchanged by Auto Setup 
• Probe Attenuation: Unchanged by Auto Setup 
• Vertical Offset: Changed by Auto Setup 
• Vertical Range: Changed by Auto Setup 

Digital Channels Digital Channels 

• Channel Enabled: Changed by Auto Setup 

Timing Timing 

• Sample Rate: Changed by Auto Setup 
• Acquisition Time: Changed by Auto Setup 
• Pretrigger Time: 50% of Acquisition Time 
• Sampling Mode: Sample 
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Triggering Triggering 

• Trigger Type: Analog Edge, Digital Edge, or Immediate (if no signal present) 
◦ Analog Edge (if Trigger Type is Analog Edge) 

▪ Trigger Source: Lowest numbered channel with signal present 
▪ Trigger Slope: Rising 
▪ Trigger Level: 50% of signal on trigger channel 

◦ Digital Edge (if Trigger Type is Digital Edge) 
▪ Trigger Source: Channel with fewest transitions greater than zero 
▪ Trigger Slope: Rising 

Advanced Digital Timing Advanced Digital Timing 

• Digital Sample Rate Control: Automatic 
• Buffer Control: Automatic 

Digital Threshold Digital Threshold 

• Threshold: Unchanged by Auto Setup 

State Mode State Mode 

• Enabled: False 

What Sampling Modes Are Supported in VirtualBench? 

The VirtualBench mixed signal oscilloscope (MSO) has three different sampling modes: 
sample, peak detect, and digital phosphor. 

Sample Sampling Mode Sample Sampling Mode 

In sample sampling mode, the MSO measures the signal at a fixed time interval, the 
sample rate. 

Peak Detect Sampling Mode Peak Detect Sampling Mode 

In peak detect sampling mode, VirtualBench internally samples the instrument at its 
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maximum sample rate and saves the maximum and minimum value of the input signal 
within your configured sample interval. This may be useful to acquire for a longer time 
while being able to detect transients. 

Digital Phosphor Sampling Mode Digital Phosphor Sampling Mode 

In digital phosphor sampling mode, the MSO measures the signal at a fixed time 
interval, as in the Sample Sampling Mode. However, instead of displaying a single 
record, the MSO aggregates many records into a single image to display all at once. 
This aggregation makes it easy to see trends and outliers in the signal. 

You can adjust the intensity to focus on trends or outliers in the data. 

Does VirtualBench Support Interleaving? 

The VB-8034/8054 does not support interleaving. 

The VB-8012 supports interleaving on both MSO analog channels. While both channels 
have an analog-to-digital converter that can operate at 500 MS/s, when a single 
channel is used, the two converters can be interleaved to sample at 1 GS/s. 

Does VirtualBench Support Interpolation? 

VirtualBench supports interpolation. This interpolation is performed automatically 
when the visible time/div is too small for acquisitions performed at the maximum 
sample rate. For example, when the sample rate is 1 GHz (1 sample per 1 nanosecond) 
and the time/div is 5 ns, only 5 samples are visible for every division, so interpolation is 
performed. 

How Do I Use the Logic Analyzer? 

The logic analyzer can be used to view and analyze digital signals. The Mixed Signal 
Oscilloscope menu, to the right of the graph, has panels that you can use to configure 
the logic analyzer: 
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• Digital 
• Trigger 

How Do I Configure Digital Lines? How Do I Configure Digital Lines? 

1. Hover over the Digital panel and click , which opens the digital menu. 
2. Enable a digital line source to view it on the graph and disable it to hide it. 

How Can I Hide All the Digital Lines and Buses at Once? How Can I Hide All the Digital Lines and Buses at Once? 

Toggle the square button on the Digital panel to enable/disable all the enabled digital 
lines and buses at once. 

How Do I Configure Buses? How Do I Configure Buses? 

1. Hover over the Digital panel and click , which opens the digital menu. 
2. Click the Buses tab. You can add three types of buses: Parallel, I2C, and SPI. 

How Do I Trigger Off the Logic Analyzer Lines? How Do I Trigger Off the Logic Analyzer Lines? 

You can select an Edge or Pattern trigger to trigger off the logic analyzer lines. 

1. Hover over the Triggers panel and click , which opens the Trigger menu. 
2. Select the Trigger type. 
3. If you select a Pattern trigger, select group of digital lines in order to set a 

triggering pattern on the lines in that group. For each digital line in the group, 
select one of the following trigger states: 
◦ X (Ignore) 
◦ 0 (Low) 
◦ 1 (High) 
◦ R (Rising) 
◦ F (Falling) 
◦ E (Either) 

Related information 

What is a Pattern Trigger? 
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How Do I Use XY Time Mode? 

The XY time mode can be used to plot the voltage of one channel against the voltage of 
another channel. Complete the following steps to configure XY time mode. 

1. Click the  icon in the upper right corner of the MSO. 
2. Select Time Mode > XY. 
3. In the XY settings panel to the right of the graph, select two channels to use as XY 

sources. 
4. Configure the Volts/Div settings of the XY sources using your scroll wheel on the 

graph or the Volts/Div controls on the channel configuration panes. 
◦ Panning vertically on the graph changes the Y axis source's vertical offset. 
◦ Panning horizontally on the graph changes the X axis source's vertical offset. 

5. Use the Time/Div control above the graph to adjust the acquisition window size. 

How Do I Use XY Time Mode to Measure the Phase Offset of Two Analog Channels? 

1. Turn on and configure XY time mode to use one of the two input channels as its X 
source and the other as its Y source. 

2. Confirm that the XY plot that appears on the graph is in the shape of an ellipse. 
3. Click on the Cursor Settings icon below the graph and select Manual cursors. 

4. Use the cursors to measure and record the total width of the XY plot as A. 
5. Use the cursors to measure and record the distance between the XY plot’s two X 

intercepts as C. 

If the top of the plotted ellipse is in the first quadrant, then the phase difference is: 

   ±sin−1(C/A) 

If instead the top of the plotted ellipse is in the second quadrant, then the phase 
difference is: 

  ±[180°−sin−1(C/A)] 

How Do I Verify That the Mixed Signal Oscilloscope Probe is 
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Compensated Properly? 

1. If you are using a switchable 1x/10x scope probe, set the oscilloscope probe slide 
switch to 10x. 

2. Connect the oscilloscope probe to the compensation tabs noting which tab is 
signal and which is GND. 

3. In the VirtualBench application, set the probe attenuation to 10x and look at the 
Mixed Signal Oscilloscope waveform. You should see a square wave. Use Auto 
Setup if necessary. 

4. Using the adjustment tool (included in the VirtualBench oscilloscope probe kit), 
adjust the compensation screw that is in the housing of the oscilloscope probe 
until you see a perfectly square waveform without overshoot or undershoot. 

Adjustment Tool 

Your probe is now properly compensated. 

What Are the Mixed Signal Oscilloscope Triggering Options 
on VirtualBench? 

You can use several types of triggering with the mixed signal oscilloscope, including 
glitch, edge, and pattern. Depending on the trigger type, the trigger source could be 
any of the following signals: 

• 34 logic analyzer inputs 
• Eight digital I/O lines 
• External trigger through the TRIG BNC 
• 60 Hz/50 Hz AC line 
• FGEN Start 

Refer to the following topics for more information. 
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What is Analog Edge Triggering? 

What Is Analog Pulse Width Triggering? 

What is Digital Edge Triggering? 

What Is Digital Pulse Width Triggering? 

What is a Pattern Trigger? 

What is a Glitch Trigger? 

What Is Hysteresis? 

What is an Immediate Trigger? 

What is the Trigger (TRIG) BNC Used For? 

What is Analog Edge Triggering? 

VirtualBench can generate a trigger on an analog signal. You must specify a source and 
an edge. An analog edge trigger occurs when a signal crosses a trigger threshold that 
you specify. You can specify the slope as either positive (on the rising edge) or negative 
(on the falling edge) to the trigger. Analog edge triggering is possible on all of the 
scope's analog input channels. The following figure shows edge triggering. 

What Is Analog Pulse Width Triggering? 

A positive analog pulse is when a signal crosses over a threshold that you specify, and 
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then back under that threshold. A negative analog pulse is when a signal crosses under 
a threshold that you specify, and then back over that threshold. An analog pulse width 
trigger occurs when the oscilloscope detects an analog pulse that fits the parameters 
that you specify. 

• You can search for pulses shorter than a certain time. 
• You can search for pulses longer than a given time. 
• You can search for pulses within a given range of time. 
• You can search for pulses outside a given range of time. 

 

Pulse width triggering is supported in firmware version 15.2 or greater. 

What Is Digital Edge Triggering? 

VirtualBench can generate a trigger on a digital signal. You must specify a source and 
an edge. 

A digital trigger is usually a TTL signal with two discrete levels: a high and a low level. 
When the signal moves from high to low or from low to high, a digital edge is created. A 
rising edge is a transition from a low logic level to a high logic level. A falling edge is a 
high-to-low transition. The following figure shows a falling-edge trigger. 

The digital edge trigger source for the oscilloscope can be any of the following signals: 

• 34 logic analyzer inputs 
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• Eight digital I/O lines 
• External trigger through the TRIG BNC 
• 60 Hz/50 Hz AC line 
• FGEN Start 

What Is Digital Pulse Width Triggering? 

A positive digital pulse is measured from a rising edge to a falling edge on a signal. A 
negative digital pulse is measured from a falling edge to a rising edge on a signal. A 
digital pulse width trigger occurs when the oscilloscope detects a digital pulse that fits 
the parameters you specify. 

• You can search for pulses shorter than a certain time. 
• You can search for pulses longer than a given time. 
• You can search for pulses within a given range of time. 
• You can search for pulses outside a given range of time. 

 

Pulse width triggering is supported in firmware version 15.2 or greater. 

 

What Is a Pattern Trigger? 

A pattern trigger acts like a combination lock. When you enter the correct combination, 
the lock opens. In the case of triggers, when the device matches the desired pattern, 
the pattern trigger is asserted. A pattern trigger allows you to configure the device to 
monitor the logic analyzer inputs for a specific pattern. When the device acquires this 
pattern, the device asserts the pattern trigger. 

The pattern trigger source for the oscilloscope can be any of the following signals: 
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• 34 logic analyzer inputs 
• Eight digital I/O lines 
• External trigger through the TRIG BNC 
• 60 Hz/50 Hz AC line 
• FGEN Start 

The digital pattern is specified using the following characters: 

• X: ignore the channel 
• 0: Match on a logic low level on the channel 
• 1: Match on a logic high level on the channel 
• R: Match on rising edge on the channel 
• E: Match on either rising or falling edge on the channel 
• F: Match on falling edge on the channel 

To meet the trigger condition, the combination of specified trigger conditions must be 
met as follows: 

• The level trigger conditions specified in a pattern (0 and 1) are logically ANDed 
together. 

• The edge trigger conditions specified in a pattern (R, E, and F) are logically ORed 
together. 

• The result of both of those operations are then logically ANDed together. 

Example 

For example, if you specify a pattern of "RFX11100" for D7-D0, that pattern specifies 
these conditions: 

Channel Pattern 
Character Description 

D7 R Match on rising edge on the channel 

D6 F Match on falling edge on the channel 

D5 X Ignore the channel 

D4 1 Match on a logic high level on the channel 

D3 1 Match on a logic high level on the channel 
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Channel Pattern 
Character Description 

D2 1 Match on a logic high level on the channel 

D1 0 Match on a logic low level on the channel 

D0 0 Match on a logic low level on the channel 

A pattern match occurs when channels D4, D3, D2 are logic high, AND lines D1, D0 are 
logic low, while D7 has a rising edge, OR D6 has a falling edge. D5 is ignored. 

The Boolean logic is shown in the following illustration. 

What Is a Glitch Trigger? 

Glitch triggering is only available in the LabVIEW or C API. A glitch is a signal that has 
the same state at two different sample clock edges but transitioned in between. This is 
only possible to detect if your sample clock rate is less than 1 GHz. If your digital 
sample rate is 1 GHz, then a glitch trigger condition will never be met. 

Since the signal maintains state during the sample period, a glitch is not visible in the 
data. 

The following figure shows both positive and negative glitches. 
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What Is Hysteresis? 

Hysteresis eliminates incorrect triggers caused by noisy signals. For example, if your 
signal contains two rising edges of different amplitudes, you can use hysteresis to 
trigger on one of the edges. Although VirtualBench uses a default amount of hysteresis 
for edge triggering, which is typically 1.4% of the vertical range, you can increase that 
value for noisy signals. 

In the Trigger configuration section, click  to view or change the trigger level and 
hysteresis value. 

Hysteresis triggering is possible on both analog channels. 

A rising edge trigger is generated when the signal crosses below the voltage specified 
by the trigger level setting minus the hysteresis value, and then crosses the trigger 
level. 

A falling edge trigger is generated when a signal crosses above the voltage specified by 
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the trigger level setting plus the hysteresis value, and then crosses the trigger level. 

What Is an Immediate Trigger? 

The mixed signal oscilloscope triggers as soon as it has enough data to complete the 
acquisition without waiting on any other condition. Immediate triggering is only 
available in LabVIEW. 

What Is the Trigger (TRIG) BNC Used For? 

The trigger BNC can be used to bring triggers into VirtualBench for use with the mixed 
signal oscilloscope or to export a trigger from VirtualBench, such as a function 
generator (FGEN) start signal. When importing a trigger, the mixed signal oscilloscope 
(MSO) can display the signal present on the TRIG BNC as a digital channel as well as 
use it as a trigger for the acquisition. When exporting a trigger, these options are 
available: 

• A pulse is sent every time the FGEN begins a new period of the signal being 
generated. 

• A pulse is sent every time the MSO triggers. 
• A pulse is sent at the frequency of the 60 Hz/50 Hz AC line. 

What If the Data on My Graph or My MSO Measurement Is Not 
What I Expect? 

The DC Offset Is Not What I Expect 

My Signal Amplitude Is Not What I Expect 
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There Is a Lot of Noise in My Measurement 

The Frequency of My Signal Is Not What I Expect 

My Square Wave Edges Show Ringing, Overshoot, or Undershoot 

My Digital and Analog Data Begin or End at Different Times 

The DC Offset Is Not What I Expect 

If you are using a switchable 1x/10x scope probe, make sure it is on the proper setting. 
Also, make sure that the channel is configured for that setting. Note that the scope 
input impedance for the VB-8012 is 1 MΩ. On the VB-8034/8054, you can use the 
VirtualBench application to set the input impedance to either 50 Ω or 1 MΩ. If you are 
measuring signals with very high output impedance, there may be a voltage drop 
across that source impedance causing a voltage error. Make sure that the scope is not 
in AC coupled mode. It should be DC coupled when the DC component is important. 

 

My Signal Amplitude Is Not What I Expect 

Oscilloscope Vertical Range Oscilloscope Vertical Range 

Make sure that the vertical range is appropriate for the signal being acquired. Use Auto 
Setup to select the proper range to display your signal, or use Vertical Setting to 
manually select the appropriate vertical range. 

Oscilloscope Bandwidth Oscilloscope Bandwidth 

The oscilloscope that you are measuring with may not have the bandwidth to perform 
the measurement. Refer to the NI VirtualBench Specifications for the bandwidth 
specification for your VirtualBench. A signal at the specified bandwidth will have its 
amplitude reduced by 3 dB or 70.7% of the amplitude of much lower frequency 
signals. 
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Bandwidth Limit Bandwidth Limit 

You can configure VirtualBench to attenuate signals above either the specified 
bandwidth or the 20 MHz filter setting by setting the Bandwidth Limit. If the bandwidth 
limit is incorrectly configured for your signal, it may result in unexpected amplitudes. 
Refer to the NI VirtualBench Specifications for the bandwidth specification for 
your VirtualBench. 

Probe Compensation Probe Compensation 

Make sure that the oscilloscope probe is compensated using the compensation tabs. 
Uncompensated probes will have an AC gain mismatch causing incorrect amplitudes. 

Probe Specifications Probe Specifications 

Using a oscilloscope probe in 1x mode will have reduced bandwidth, which makes the 
signal amplitude look smaller at higher frequencies. 

Note  The VB-8012 ships with 1x/10x switchable oscilloscope probes. The VB-8034/8054 ships 
with 10x oscilloscope probes. 

Oscilloscope Flatness Oscilloscope Flatness 

The oscilloscope that you are measuring with may not have adequate flatness over 
frequency to perform the measurement. Note that some small amplitude variations 
are acceptable over frequency. 

There Is a Lot of Noise in My Measurement 

For the lowest-noise measurements, use the slide-on spring clip to make a ground 
connection instead of the snap-on alligator clip. Ground your probe as close to the 
signal as possible. If you are using noisy power supplies in your circuit try to filter 
them. 

The Frequency of My Signal Is Not What I Expect 
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Check the Timebase Check the Timebase 

The signal may be aliased to a lower frequency due to undersampling and decimation 
when a large timebase is displayed. Decrease the time per division to correct this by 
zooming in or using the Horizontal Setting. You can also use the Auto Setup function. 

Check Bandwidth Filter Setting Check Bandwidth Filter Setting 

By default, the mixed signal oscilloscope (MSO) displays frequencies up to the 
maximum bandwidth limit of the device. Refer to the NI VirtualBench 
Specifications for the bandwidth specification for your VirtualBench. Signals with 
frequencies much lower than the maximum limit may show unwanted high-frequency 
noise. Set the Bandwidth Limit to attenuate the noise. 

My Square Wave Edges Show Ringing, Overshoot, or Undershoot 

Make sure the mixed signal oscilloscope (MSO) probe is compensated. Connect the 
probe to the compensation tabs. Adjust the variable capacitor on the scope probe with 
the plastic adjustment tool (included with the scope probe) until the square wave 
edges are clean with no overshoot or undershoot. 

The higher the frequency measured the more important it is to make a good ground 
connection. The scope probes come with two grounding options, the snap-on alligator 
clip or the slide-on spring clip. The spring clip creates a very small ground loop and is 
ideal for high frequency measurements (such as square waves with fast edges). 

Related information 

How Do I Verify That the Mixed Signal Oscilloscope Probe is Compensated Properly? 

My Digital and Analog Data Begin or End at Different Times 
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Analog and digital data are captured differently by the VirtualBench mixed signal 
oscilloscope (MSO). Analog data is stored at a regular interval determined by the time/
div setting on your MSO. Digital data is only stored when the data signals being 
acquired change values, so depending on the activity of the signals you are measuring, 
the total amount of time stored will vary and may be longer or shorter than the time 
stored for the analog data. 

To get more digital data: 

• Turn off any unconnected or unused logic analyzer channels. Noise on these 
channels can cause extra data to be stored and fill the available buffer faster. 

• Remove very high frequency signals from the logic analyzer channels being 
acquired. High-frequency signals, such as clocks, fill the available buffer faster. 

• Ensure that the Maximum Digital Buffer Size setting is set to a high enough value. 
The highest setting is 1 Million Transitions. The setting is located on the 
Acquisition submenu of the Digital channel configuration menu. 

Why Can't I Sample at 1 GS/s with Two Channels (VB-8012)? 

The VB-8012 has two 500 MS/s ADCs. To achieve a sample rate of 1 GS/s, both 500 MS/s 
ADCs are used. They sample at the maximum sampling rate, but are offset by a half 
clock period. The data is then interleaved to produce a waveform with a 1 GS/s sample 
rate for a single channel. 
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What Is a Reference Channel? 

A reference channel is a snapshot of the state of an analog channel. A reference 
channel acts just like other analog channels but its data does not change after the 
snapshot is taken. Measurements, cursors, etc. can be used on reference channels. 

Related information 

Which Channels Can I Use as Data Sources for Reference Channels? 

How Do I Save Reference Channels? 

Which Channels Can I Use as Data Sources for Reference Channels? 

You can use enabled analog channels and enabled math channels (excluding FFT) as 
data sources for reference channels. You cannot use digital channels, FFT channels, 
disabled channels, and other reference channels as data sources for reference 
channels. 

How Do I Save Reference Channels? 

To capture a reference channel, open the More Channels dialog, select the reference 
channel to use in the list on the left, select the source channel from the drop down on 
the right, and then click the Capture button. 

Captured reference channels are saved automatically and load automatically the next 
time you launch the VirtualBench application on the same computer. However, 
reference channels are device specific, so that, for example, reference channels taken 
while using a VB-8012 will not load if you then connect to a VB-8034/8054. Reference 
channels can also be manually saved to or loaded from files using the More Channels 
dialog. 
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Function Generator (FGEN) 

Why is My DC Output Voltage Not What I Expect? 

How Do I Output an Arbitrary Waveform? 

How Does VB-8054 Self-Calibration Work? 

How Can I Verify My FGEN Outputs? 

Why Do My Square Wave Edges Show Ringing, Overshoot, or Undershoot? 

Why Are My Square Wave Edges Too Slow? 

Why Doesn't the FGEN Start Immediately Generate a Signal When the Output Is First 
Started? 

Why Is My DC Output Voltage Not What I Expect? 

The output impedance for the FGEN is 50 Ω. The load impedance that you put on the 
output will cause a voltage divider with the 50 Ω output impedance and reduce the 
voltage compared to what you program. For example, if you have a 50 Ω load, you will 
see half the amplitude. If you have a 100 Ω load, you will see 2/3 the amplitude. If you 
have a high impedance load, such as a DMM, you will see 100% of the programmed 
value. The output is designed to drive a load ≥50 Ω. A smaller load may cause an 
unexpected error. 

How Do I Output an Arbitrary Waveform? 

1. On the FGEN panel, click on the ARB button. 
2. Use the Browse button under Waveform Data File to open a data file. 
3. Select an Output. 
4. Adjust Gain and DC Offset if needed. 
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The following types of Waveform Data files are supported: 

• Text (.txt) with one value per line. Values are in volts. Units are omitted. This type of 
file produces only one waveform. (sample.txt) 

• CSV files (.csv) where each column has a value for each waveform. Values are in 
volts. Units are omitted. (sample.csv) 

• CSV Pitch files (.csv) obtained from PhysioBank at physionet.org. (sample2.csv) 

Why does the value of gain and offset change when I load a different Why does the value of gain and offset change when I load a different 
data file or select a different output? data file or select a different output? 

When you load a new data file, or select a different output, the gain and offset 
automatically reset to a gain of 1 and an offset of 0. 

If the waveform has values outside the range ±12 V, the VirtualBench keeps offset at 
zero and uses the maximum gain possible to keep the output inside the range. 

Why do gain and offset ranges vary from one data file to another? Why do gain and offset ranges vary from one data file to another? 

The maximum output range supported by the device is ±12 V. In order to keep the 
output in range, VirtualBench considers the maximum and minimum values of the 
waveform loaded from the file. When deciding the range values for gain, VirtualBench 
considers the current value of the offset, and when deciding the range values for 
offset, VirtualBench considers the current value of the gain. A change in one affects the 
range of the other. 

How Does VB-8054 Self-Calibration Work? 

The VB-8054 FGEN supports self-calibration. This operation measures the output offset 
error and compensates for it for all functions. Calibration is useful if the offset error has 
drifted over time or if the unit is subject to an ambient temperature significantly 
different than the temperature previously used for calibration. 

1. In the upper right corner of the FGEN panel of the application, click the  icon and 
select Self-Calibrate. 

2. Disconnect all loads from the function generator and click Begin Self-Calibration. 
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This operation should take less then 10 seconds. When the operation completes, your 
FGEN has calibrated its offset error. 

Related Information 

Calibration 

 

How Can I Verify My FGEN Outputs? 

Verifying DC Outputs Verifying DC Outputs 

Use the digital multimeter (DMM) to verify DC outputs. A DMM has a high impedance 
input so the DC value measured should be 100% of the programmed value. 

1. Attach the red probe to the DMM HI connector. 
2. Attach the black probe to the DMM LO connector. 
3. Launch the VirtualBench application. 
4. Output a DC voltage from the FGEN in DC mode and turn the output on. 
5. Configure the DMM for DC volts, auto range. 
6. Simultaneously, touch the tip of the red probe to the center pin of the FGEN BNC 

connector and the tip of the black probe to the shield of the FGEN BNC. 
7. The DMM should read the programmed voltage. 

Verifying AC Outputs Verifying AC Outputs 

Use the mixed signal oscilloscope (MSO) to verify AC outputs (sine, square, triangle 
waves). Make sure that the MSO has adequate bandwidth, otherwise you will see the 
amplitude decrease with frequency. Make sure that the oscilloscope probe is 
compensated properly. 

1. Launch the VirtualBench application. 
2. Plug the oscilloscope probe into an oscilloscope channel. 
3. If you are using a switchable 1x/10x scope probe, move the slide switch on the 

probe to 10x. 
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Note  Using the oscilloscope probe in 1x mode will have reduced bandwidth, which 
makes the signal amplitude look smaller at higher frequencies. 

4. Ensure the probe attenuation setting for your channel is set to 10x 
5. Connect the oscilloscope probe ground clip to the shield of the FGEN BNC 

connector. 
6. Touch the tip of the oscilloscope probe to the center pin of the FGEN BNC. 
7. Zoom in/out of the timebase and range to see the full signal on the oscilloscope 

channel you are verifying. 

Tip  You can also use the Auto Setup button. 

8. Make sure the signal amplitude and frequency are what you expect. 

 

Related information 

How Do I Verify That the Mixed Signal Oscilloscope Probe is Compensated Properly? 

Why Do My Square Wave Edges Show Ringing, Overshoot, or 
Undershoot? 

You probably have an impedance mismatch. Make sure the system has matched 
impedances, 50 Ω impedance cables, and a 50 Ω load. Capacitive or inductive loads 
can cause undesirable square wave ringing, undershoot, or overshoot. 

Why Are My Square Wave Edges Too Slow? 

Refer to the rise/fall time specification in the NI VirtualBench Specifications for 
the expected rate. Edges will be slowed if driving a capacitive load. The 50 Ω output 
impedance along with the capacitive load causes a lowpass filter that can slow your 
edges. 
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Why Doesn't the FGEN Start Immediately Generate a Signal 
When the Output Is First Started? 

The function generator start trigger fires at the end of each periodic buffer output. The 
FGEN must cycle through one period of a standard waveform before it will assert for 
the first time. 
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Digital I/O (DIO) 

Can the Digital I/O lines Be Used for Static DIO? 

What Are the Power-On States for the Digital I/O Lines? 

What Can I Do with the Digital I/O? 

Can the Digital I/O lines Be Used for Static DIO? 

Each of the VirtualBench digital lines can be used as a static DI or DO line. You can use 
static DIO lines to monitor or control digital signals. All samples of static DI lines and 
updates of DO lines are software-timed. 

What Are the Power-On States for the Digital I/O Lines? 

At system startup and reset, the hardware sets all DIO lines to high-impedance inputs. 
The device does not drive the signal high or low. All eight DIO lines have 10 kΩ pull-
down resistors connected to them. 

What Can I Do with the Digital I/O? 

General-purpose I/O (GPIO)—You can individually configure each line as an input or 
output. Each of these lines has a 10 kΩ pull-down resistor when used for GPIO. 
Outputs can be driven high to 3.3 V or low to ground. 

Exported signal output—Each line can export the MSO Trigger or FGEN Start signal. 
When importing a trigger, the mixed signal oscilloscope (MSO) can display the signal 
present on the digital I/O connector as a digital channel as well as use it as a trigger for 
the acquisition. When exporting a trigger, these options are available: 

• A pulse is sent every time the function generator (FGEN) begins a new period of the 
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signal being generated. 
• A pulse is sent every time the MSO triggers. 
• A pulse is sent at the frequency of the 60 Hz/50 Hz AC line. 

SPI bus mastering—You can use VirtualBench’s digital I/O to interface to serial 
peripherals. When you configure a SPI bus, a set of lines are reserved for the bus and 
each line's direction is automatically configured. 

spi/0 bus 
dig/0: Clock output 
dig/1: MOSI (Master Out Slave In) 
dig/2: MISO (Master In Slave Out) 
dig/3: CS (Chip Select) output 

I2C bus mastering—You can use VirtualBench to master an I2C (Inter-Integrated Circuit) 
bus. When you configure an I2C bus, a set of lines are reserved for the bus and each 
line's direction is automatically configured. By default, all the GPIO lines have a 10 kΩ 
pull-down resistor connected. When used in I2C mode, they can be configured to have 
a pull-up instead. On the VB-8012, this pull-up has a value of 10 kΩ. On the VB-8034/
8054, it is a value of 1.5 kΩ. 

i2c/0 bus 
dig/6: SCL (Serial Clock) output 
dig/7: SDA (Serial Data) input/output 

Related information 

What Is a Pattern Trigger? 
What Is Digital Edge Triggering? 
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DC Power Supply 

How Do I Combine Multiple Outputs of the DC Power Supply? 

What If My DC Power Supply Is Not Reading Back the Correct Voltage or Current? 

What Do CV and CC Indicate in the VirtualBench Application? 

How Do I Combine Multiple Outputs of the DC Power 
Supply? 

Caution  Do not exceed 60 VDC from any terminal to ground when cascading power supplies. 

You can cascade multiple channels in series to generate greater voltage because the 
+25 V and - 25 V channels on the DC power supply are isolated from ground. For safety 
reasons, all terminals must be <60 VDC from ground. Any terminal on the isolated 
channels can be connected to ground. When you cascade channels in series, the DC 
power supply can generate up to 50 V, as shown in the following table. 

Caution  The NI VirtualBench DC power supply does not provide isolation when using the +6V 
channel. 

Cascading Multiple Channels in Series Diagram 

VB-8012: Up to +50 V, +500 mA 
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VB-8012: Up to -50 V, -500 mA 

VB-8034/8054: Up to +50 V, +1 A 

VB-8034/8054: Up to -50 V, -1 A 

What If My DC Power Supply Is Not Reading Back the Correct 
Voltage or Current? 

The VirtualBench DC power supply is a system of setpoint DACs and readback ADCs. 
Each setpoint and readback channel will have calibration accuracy and load 
regulation, as specified in the DC Accuracy table in the NI VirtualBench 
Specifications. Under normal operation, the readback channels will differ from the 
setpoints within the accuracy window. 

The DC power supply output stage is fault protected, described in the output channel 
protection specification in the NI VirtualBench Specifications. In the event an 
output exceeds the maximum channel ratings or the temperature exceeds the 
environmental specifications, described in the NI VirtualBench Specifications, 
the thermal protection circuitry will trip and limit available output power. Remove the 
load from the output channels and allow the device to cool sufficiently. Once cool, test 
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the channel in question as described below. 

Validating an Output Channel Validating an Output Channel 
For the following procedure ensure no external load is connected to the DC power 
supply. Connect the Common Floating Ground terminal to the GND terminal. Refer to 
VB-8012 DC Power Supply Connections and LEDs or VB-8034/8054 DC Power Supply 
Connections and LEDs for the DC power supply connections on your VirtualBench. 
Open the VirtualBench application. 

Validating Constant Voltage Mode: 

1. Connect the VirtualBench Digital Multimeter (DMM) HI (red, Volts) to the output 
channel to test and LO (black) to ground. 

2. Set the DMM to DCV, Auto Range or 100 V. 
3. Set the DC power supply test channel to its maximum available output current. 
4. Set the DC power supply test channel to a voltage to test. 
5. Enable the DC power supply. 

The DMM Volts and DC power supp voltage setpoint and voltage readback channels 
should agree within DC accuracy specifications, listed in the DC Accuracy table in the 
NI VirtualBench Specifications. The current readback should be near zero within 
DC accuracy specifications. The DC power supply mode indicator should read CV. 

Validating Constant Current Mode: 

1. Connect the VirtualBench DMM A (red, Amps) to the output channel to test and LO 
(black) to ground. 

2. Set the DMM to DCA, Auto Range or 10 A. 
3. Set the DC power supply test channel to its maximum available output voltage. 
4. Set the DC power supply test channel to a current to test. 
5. Enable the DC power supply. 

The DMM Amps and DC power supply current setpoint and current readback channels 
should agree within DC accuracy specifications, listed in the DC Accuracy table in the 
NI VirtualBench Specifications. Voltage readback should be the burden voltage of 
the DMM 10 A range at the test current applied. The DC power supply mode indicator 
should read CC. 
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What Do CV and CC Indicate in the VirtualBench Application? 

The CV and CC indicators on the DC Power Supply instrument display the mode of the 
output channels. 

• CV indicates the power supply is operating in Constant Voltage mode. The supply 
operates in Constant Voltage mode if the load does not require more current than 
the channel current limit. 

• CC indicates the power supply is operating in Constant Current mode. The supply 
operates in Constant Current mode if the load attempts to draw more current than 
the channel current limit. 

The VirtualBench device has LEDs that indicate the mode of the three channels. The 
color of the LED matches the color of the CV and CC indicators in the application, blue 
and orange respectively. 

 

Related Information 

VB-8012 DC Power Supply Connections and LEDs 

VB-8034/8054 DC Power Supply Connections and LEDs 
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Digital Multimeter (DMM) 

How Does Null Offset Work? 

Why Does My Digital Multimeter Measurement Always Read 0 A Current? 

How Does Null Offset Work? 

Null Offset stores the current reading of the DMM and subtracts it from any future 
readings. The stored offset shows on the display. When enabled, the Null Offset value 
updates if the device, function, or range changes. 

Why Does My Digital Multimeter Measurement Always Read 0 
A Current? 

If the Digital Multimeter (DMM) always reads about 0.00 A or 0.00 mA when measuring 
current, the cause may be a blown fuse. 

Related information 

How Do I Test a Fuse? How Do I Replace a Fuse? 
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General Information 

What Are the Different Ways to Run the VirtualBench Application? 

How Can I Monitor Instruments In Use by the API? 

How Can I Save, Share, and Import VirtualBench Configurations? 

How Can I Troubleshoot Wireless Network Problems? 

How Can I Troubleshoot Ethernet Network Problems? 

How Do I Calibrate VirtualBench? 

How Do I Capture Data or Screenshots with VirtualBench? 

How Do I Install the VirtualBench Application? 

How Do I Update the VirtualBench Firmware? 

How Can I Password Protect VirtualBench Firmware Modifications? 

How Do I Use LabVIEW with VirtualBench? 

How Do I Use the VirtualBench with My iPad? 

What Cables and Accessories Can Be Used with VirtualBench? 

What Is the Best Way to Clean VirtualBench? 

What Type of Fuses Does VirtualBench Use? 

What is the Earliest Supported Version of the VirtualBench Application for My 
VirtualBench? 

Why Doesn't the VirtualBench Application Start Automatically? 
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Why Is the Fan Loud? 

Why Is the Power LED Blinking? 

Why Is There a Flag on the VirtualBench Application? 

What Are the Different Ways to Run the VirtualBench 
Application? 

VirtualBench is preloaded with VirtualBench application. You can run the software 
from the device, or you can install the software on your computer and run it from your 
Start menu. 

Running the VirtualBench Application from the VirtualBench Running the VirtualBench Application from the VirtualBench 
Hardware Hardware 

VirtualBench uses Windows AutoPlay to launch the software automatically when 
VirtualBench is connected to a computer using a USB cable. If the software does not 
launch automatically, refer to Why Doesn't the VirtualBench Application Start 
Automatically?. 

If you prefer to manually start the software, refer to Manually Start the VirtualBench 
Application. 

Running the VirtualBench Application from Your Computer Running the VirtualBench Application from Your Computer 

Running the software from your computer can improve performance and allows you 
set up a wireless connection from your computer to the VirtualBench hardware. Refer 
to How Do I Install the VirtualBench Application?. 

Once the software is installed, you can launch it from the Windows Start menu or 
(Windows 8.1/8) NI Launcher. To launch the software from the Start menu (Windows 
7/Vista/XP), select All Programs»National Instruments»NI VirtualBench, or (Windows 
10), select All apps»NI VirtualBench. 
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How Can I Monitor Instruments In Use by the API? 

You can use the VirtualBench application to monitor instruments that are being 
controlled by the LabVIEW or C API. When you are actively controlling an instrument 
from the API, the corresponding instrument in the VirtualBench application enters 
monitor mode. While in monitor mode, the VirtualBench application continues to 
monitor the instrument as programmed by the API and receives both settings and data 
updates. The VirtualBench application cannot configure an instrument while it is 
controlled by the API. When the instrument is released by closing the API session, you 
can control it through the VirtualBench application. Monitor mode is supported in 
firmware version 1.2 or greater. 

Note  Instruments in monitor mode display in the VirtualBench application with the  icon in 
the instrument heading. 

How Can I Save, Share, and Import VirtualBench 
Configurations? 

You can save instrument configuration to a file that you can save for later use or share 
with colleagues or to the device for later reference. 

1. Select File»Export Configuration. 
2. Select To Device to save it to VirtualBench storage or To Computer to save it to 

your PC. 

Use File»Import Configuration to reconfigure VirtualBench to previously saved 
configurations. 

Note  You can save up to 10 configuration files on VirtualBench storage. 

How Can I Troubleshoot Wireless Network Problems? 

If you are having trouble connecting to the VirtualBench device, try the following tips: 
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• Disable your computer's firewall to make sure the firewall is not blocking the 
connection, or configure your firewall to allow the following ports to be used: 
◦ 5353 UDP for device discovery. 
◦ 9090 TCP for instrument control. 

• Disable any Virtual Machine network adapters such as VMWare. These adapters can 
route traffic incorrectly and cause the VirtualBench to not be discovered or used. 

• Verify that the antenna is connected. 

Related information Related information 

Connecting to VirtualBench Using an Existing Wireless Network Why Doesn't the 
VirtualBench Application Start Automatically? How Do I Install the NI VirtualBench 
Application on My computer? What Are the Different Ways to Run the NI VirtualBench 
Application? Reset Button Wireless LED 

How Can I Troubleshoot Ethernet Network Problems? 

If you are having trouble connecting to the VirtualBench hardware, try the following 
tips: 

• Confirm that the Ethernet Connectivity LED on the front panel is lit, and the 10/
100/1000 and LINK/ACT LEDs on the Ethernet connector on the back panel are lit. 

• Ensure that the version of the VirtualBench application installed on your computer 
supports your VirtualBench. Refer to the What is the Earliest Supported Version of 
the VirtualBench Application for My VirtualBench? topic for the software version to 
install on your computer. 

• VirtualBench can also be accessed through a web browser. Type the host name or 
IPv4 address of the VirtualBench in your web browser. The NI Network Browser, 
which can show you all the NI configurable hardware on your local subnet, can 
also be accessed by going to Start»All Programs»National Instruments»NI 
Network Browser. The device can be accessed through the web on a host PC that 
does not have any NI software installed. 

• IPv4 configuration can be set to automatically assign via the DHCP server on the 
host PC. Manually/statically setting the IPv4 address for the host computer may 
potentially put the VirtualBench on a separate subnet and therefore make it 
undiscoverable. Microsoft's web site explains how to change the IPv4 configuration 
in Windows; search for information about changing TCP/IP settings for your 
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Windows version. 
• If connecting VirtualBench directly to a host PC, make sure that the computer is 

either running a DHCP server or the network card is set to obtain an IP address 
automatically. VirtualBench always looks for a DHCP server first and if one is not 
available, it will default to a link local IP address. Link local IPv4 addresses are in 
the following range: 169.254.1.0 to 169.254.254.255 with the subnet 
mask 255.255.0.0. Setting your computer to have a static IP address, 169.25
4.X.X, with the subnet mask 255.255.0.0 will ensure that the device and your 
computer are on the same subnet. 

• Connect the VirtualBench hardware to your computer using the USB cable. The 
VirtualBench application should start automatically. If it does not, refer to Why 
Doesn't the VirtualBench Application Start Automatically?. In the application, click 
the wireless icon and select Ethernet. View the network details by selecting 
Automatic configuration or change the network configuration by selecting Manual 
configuration and then enter configuration setttings. Click Apply. Close the 
VirtualBench application and open your computer's network settings and connect 
to the VirtualBench device. Then disconnect the USB cable and launch the 
VirtualBench application from your Start menu. Click Search for Device. The 
VirtualBench should be listed in the Select a device window. 

• Disable your computer's firewall to make sure the firewall is not blocking the 
connection, or make sure your firewall settings allow for the network ports listed in 
the NI VirtualBench Specifications. 

• If using a proxy server, add the address of the VirtualBench to the list of exceptions. 
This setting can be found in Internet Options. 

• Try disabling any antivirus software, it may be interfering with the discovery or 
configuration process. 

• Disable any virtual machine network adapters such as VMware. These adapters can 
route traffic incorrectly and cause VirtualBench to not be discovered or used. 

• If working through the previous tips do not result in finding your VirtualBench, 
reboot VirtualBench by pressing the reset button as described in the Reset Button 
topic. 

Related information Related information 

Ethernet LEDs Reset Button What is the Earliest Supported Version of the VirtualBench 
Application for My VirtualBench? 
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How Do I Calibrate VirtualBench? 

The VirtualBench analog inputs and outputs on the mixed signal oscilloscope (MSO), 
digital multimeter (DMM), DC power supply, and function generator (FGEN) have 
calibration circuitry to correct gain and offset errors. You can calibrate the device to 
minimize errors caused by time and temperature drift at run time. 

Device calibration consists of verifying the measurement accuracy of a device and 
adjusting for any measurement error. Verification consists of measuring the 
performance of the device and comparing these measurements to the published 
specifications. During calibration, you supply and read voltage levels or other signals 
using external standards, then you adjust the device calibration constants. The new 
calibration constants are stored in the non-volatile onboard storage. These calibration 
constants are loaded from memory as needed to adjust for the error in the 
measurements taken by the device. 

External calibration, which is typically performed by a metrology lab, requires using a 
high-precision voltage source to verify and adjust calibration constants. This 
procedure replaces all calibration constants in the non-volatile onboard storage and is 
equivalent to a factory calibration. Because the external calibration procedure changes 
all non-volatile stored constants, it invalidates the original calibration certificate. If an 
external calibration is done with a NIST-certified voltage source, a new NIST 
traceability certificate can be issued. 

Calibrating VirtualBench requires installation on the calibration system of one of the 
following: 

• NI-VirtualBench and NI LabVIEW—For a detailed calibration procedure, search for 
the NI VirtualBench Calibration Procedure at ni.com/calibration. 

• Calibration Executive—The Calibration Executive integrated environment is used 
for verifying and adjusting NI measurement devices. No programming is required. 
Refer to the Calibration Executive Help at ni.com/manuals. 

Related Information 

How Does VB-8054 Self-Calibration Work? 
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How Do I Capture Data or Screenshots with VirtualBench? 

You can capture data with VirtualBench in several ways. 

Saving and Exporting a Snapshot as a PNG File Saving and Exporting a Snapshot as a PNG File 

Complete the following steps to take a snapshot of your VirtualBench measurements. 

1. Click the  icon in the title bar. 

Tip  You can also press Ctrl+Shift+S. 

2. In the window that opens, select a file location for your PNG file and click Save. 
The snapshot is taken at this moment. 

Saving a Screenshot to the Computer Clipboard Saving a Screenshot to the Computer Clipboard 

Complete the following steps to save a screenshot of the software to your computer 
clipboard. 

1. Select File»Copy. 
2. Paste the image to another application. 

Saving and Exporting Data as a Spreadsheet Saving and Exporting Data as a Spreadsheet 

Complete the following steps to save a comma-separated values (CSV) file of 
datapoints of your VirtualBench measurement. 

1. Click the  icon in the title bar. 

Tip  You can also press Ctrl+Shift+X. 

2. In the window that opens, select a file location for your CSV file and click Save. 

Tip  You can open CSV files in Microsoft Excel or Notepad. 
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Saving and Exporting With Hands-Free Smart Capture Saving and Exporting With Hands-Free Smart Capture 

When you enable Smart Capture, the application can automatically perform an action 
when it detects a stable, analog signal. You can configure Smart Capture to export a 
screenshot (png), export data (csv), or stop the MSO. Complete the following steps to 
enable Smart Capture. 

1. Click the  icon in the title bar. 
2. Configure the settings shown in the Hands-Free Smart Capture settings window. 
3. Check Enable Smart Capture. Capturing begins immediately if the MSO has a 

stable signal. 

 

How Do I Install the VirtualBench Application? 

Installing the VirtualBench application on your computer can improve performance 
and allows you set up a wireless connection from your computer to the VirtualBench 
hardware. 

You can download the VirtualBench application installer from ni.com/support. Follow 
the instruction in the installation wizard to install the software on your PC. 

To learn about other ways to run the VirtualBench application, refer to What Are the 
Different Ways to Run the VirtualBench Application?. 

How Do I Update the VirtualBench Firmware? 

The VirtualBench application automatically checks for updates to the firmware at 
startup. A notification flag appears if a firmware update is available. Click the 
notification flag to open the firmware update dialog box. (If the update is critical, the 
dialog box opens automatically.) Follow the prompts in the dialog box to continue. 

If you want to check if your firmware is up to date, select Search for Firmware Update 
from the File menu. 

VirtualBench User Manual

© National Instruments 71



Related information Related information 

How Can I Password Protect VirtualBench Firmware Modifications? 

How Can I Password-Protect VirtualBench Firmware 
Modifications? 

In some environments, such as academia, it is beneficial to add a security measure to 
prevent firmware changes. You can password-protect your VirtualBench to prevent 
others from making firmware updates. 

The VirtualBench application automatically checks for updates to the firmware at 
startup. The default username and password are stored in the application itself, so 
choosing to upgrade firmware automatically begins installing the update. 

To change this behavior, you can change the default password in the web interface of 
the VirtualBench device. 

1. Obtain the IP address of the VirtualBench by opening NI MAX on your computer 
and selecting your VirtualBench under Devices and Interfaces. 

2. Click the Settings tab and view and copy the first IPv4 Address. 
3. In a web browser, navigate to the IPv4 Address. 
4. Log in with the default credentials of your VirtualBench: User name = admin, 

Password = leave blank. 
5. Navigate to the security configuration screen and set a new password on the 

admin account. This will prevent firmware updates from being installed without a 
password. 

Related information Related information 

Reset Button How Do I Update the VirtualBench Firmware? 

How Do I Use LabVIEW with VirtualBench? 

In addition to taking measurements with the VirtualBench application, you can also 
build custom software for your VirtualBench with LabVIEW and the NI VirtualBench 
application development software. LabVIEW uses graphical icons and wires that 
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resemble a flowchart, so you can graphically wire together function blocks to create 
your own applications for logging data, alarming, triggering, reporting, and performing 
real-time data analysis. 

To use LabVIEW with the VirtualBench, complete the following steps. 

1. Install LabVIEW from ni.com/support. 
2. Install the NI VirtualBench application development software from ni.com/

support. 
3. To use LabVIEW over wireless or Ethernet, first configure the network connection 

using the VirtualBench application. Once the network is established, you can use 
LabVIEW with your VirtualBench over the network from then on. 

Related information Related information 

Connecting to VirtualBench Using Wireless 

Connecting to VirtualBench Using Ethernet 

How Can I Monitor Instruments In Use by the API? 

How Do I Use VirtualBench with My iPad 

To use VirtualBench with your iPad, follow these steps: 

1. Connect the power cable and antenna to the VirtualBench. 
2. Install and open the VirtualBench app, available from the iTunes Store. 
3. Follow the on-screen instructions. 

What Cables and Accessories Can Be Used with 
VirtualBench? 
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Replacement Cables and Accessories Replacement Cables and Accessories 

Cable/Accessory 
 Part Number 

 VB-8012   VB-8034/8054 

Wireless Antenna 780704-01 

DMM Probes (set of 2) 783567-01 761000-01 

MSO Logic Analyzer 40 Pin Input Cable 158292-01 154454-01 

Oscilloscope Probes 
 783566-01 
(150 MHz, set of 
2) 

 784471-01 
(500 MHz, set of 
4) 

USB Cable with Locking Screw, 2 m 780534-01 

VirtualBench Accessory Kit 
(contains instrument screw-terminal connectors and NI 
screwdriver) 

783565-01 784470-01 

VirtualBench Fuse Replacement Kit 
(contains two pairs) 784476-01* 784477-01* 

*Not sold in Japan. See What Type of Fuses Does VirtualBench Use? for OEM 
alternatives. 

Additional Cables and Accessories Additional Cables and Accessories 

Cable/Accessory 
 Part Number 

 VB-8012   VB-8034/8054 

Desktop Mounting Kit  783569-01  — 

Binding Post Adapter 783538-01 — 

Soft Carrying Case 783537-01 784469-01 

Accessory Pouch 783586-01 

Oscilloscope Probe, 200 MHz (1 probe) 780284-01 — 

Set of 6 Logic Analyzer Grabbers 783539-01 

BNC Male to Micrograbber Cable, 31 cm 783812-01 

50 Ω BNC Cable, Male to Male, 2 m 159103-02 
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Cable/Accessory 
 Part Number 

 VB-8012  VB-8034/8054 

DMM Probe Set with Alligator Clips, Spade Connectors, and Spring 
Hooks 184698-01 

USB Cable with Locking Screw, 1 m 198506-01 

CAT-5E Ethernet Cable, 2/5/10 m lengths —  151733-02/05/
10 

What Type of Fuses Does VirtualBench Use? 

VirtualBench has two replaceable fuses that protect the device from overcurrent 
through the DMM current connectors. Two pairs of the fuses are included in the 
VirtualBench Fuse Replacement kit. 

VirtualBench Replacement Fuses 

Accessory 
 Part Number 

 VB-8012   VB-8034/8054 

VirtualBench Fuse Replacement Kit 
(contains two pairs) 784476-01 784477-01 

The VirtualBench Fuse Replacement Kit is not sold in Japan. The following table 
contains specifications for the fuses in the replacement kit. Fuses can also be ordered 
directly from the suppliers listed in the table. 

 VirtualBench   DMM Current 
Connector  Fuse 

VB-8012 

A T 10A H 250V (5 x 20 mm) fuse (Bussmann part number 
S505H-10-R at www.cooperindustries.com) 

mA T 1.25A H 250V (5 x 20 mm) fuse (Bussmann part number 
S505H-1.25-R at www.cooperindustries.com) 

VB-8034/8054 A F 11A 1000V (10.3 x 38 mm) fuse (SIBA part number 5019906.11 at 
www.siba-fuses.com) 
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mA T 1A H 400V (5 x 20 mm) fuse (Littelfuse part number 
0477001.MXP at www.littelfuse.com) 

Note  If the Digital Multimeter (DMM) always reads about 0.00 A or 0.00 mA when measuring 
current, the cause may be a blown fuse. 

Related information 

How Do I Test the Fuse?How Do I Replace a Fuse? 

How Do I Test the Fuse? 

To test for a blown fuse, complete the following steps. 

1. Using a DMM test probe, connect the HI (V) terminal and probe the DMM current 
(mA or A) connector on the hardware. 

2. Launch the NI VirtualBench application. 
3. In the Digital Multimeter (DMM) area, click the  icon to put the DMM in resistance 

mode. 

If the fuse is blown, the display shows OVER Ω, OVER kΩ, or OVER MΩ, indicating a 
disconnected circuit path. Replace the fuse and complete the procedure again. 

 

Related information 

What Type of Fuses Does the VirtualBench Use? How Do I Replace a Fuse? 

How Do I Replace a Fuse? 

To replace a broken fuse, complete the following steps. 

1. Power off and unplug the device. 
2. Remove the USB cable, Ethernet cable, and all signal wires from the device. 
3. On the underside of the device, remove the fuse housing cover with a #1 Phillips 
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head screwdriver. 
4. Replace the broken fuse. 
5. Replace the cover. 

Related information 

What Type of Fuses Does VirtualBench Use? 

What Is the Earliest Supported Version of the VirtualBench 
Application for My VirtualBench? 

 VirtualBench   Earliest VirtualBench Application Version Support 

VB-8012 VirtualBench 1.0 

VB-8034 VirtualBench 15.1 

VB-8054 VirtualBench 16.1 

Why Doesn't the VirtualBench Application Start 
Automatically? 

VirtualBench uses Windows AutoPlay to launch the software automatically when 
VirtualBench is connected to a computer. If no software launches after you plug in your 
device, AutoPlay may be disabled on your system. Here are some possible solutions to 
this problem: 

• Enable AutoPlay 
• Enable the AutoPlay Group Policy 
• Laptop Docking/Undocking Issues 
• Manually Select AutoPlay 
• Manually Start the VirtualBench Application 

Enable AutoPlay 

Windows 10 
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1. Type AutoPlay in the search box. 
2. Click AutoPlay settings in the search results. 
3. Turn on Use AutoPlay for all media and devices. 

Windows 8.1/8/7/Vista 

1. Launch the Control Panel. 
2. Type AutoPlay in the search box. 
3. Click AutoPlay in the search results. 
4. Select Use AutoPlay for all media and devices. 

Windows XP 

1. Click My Computer from the desktop or Start menu. 
2. Right-click the VirtualBench device and select Properties. 
3. On the AutoPlay tab, ensure that Prompt me each time to choose an action is 

selected for each content type. 

 

Enable the AutoPlay Group Policy 

Note  Your IT department may have set the group policy for your computer, in which case they 
will have to enable it for you as described below. 

If no AutoPlay option exists when you right-click the VirtualBench device, an existing 
group policy may have disabled this feature. The following instructions show how to 
turn it back on. Note that the instructions require Administrative access. 

Windows 10/8.1/8 

1. Open the Group Policy Editor by entering gpedit.msc in the Run app or 
Command Prompt (cmd.exe). 

2. In the left pane, click Local Computer Policy»Computer 
Configuration»Administrative Templates»Windows Components»AutoPlay 
Policies. 

3. In the right pane, double click Turn off AutoPlay. 
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4. In the dialog box that opens, click the Disabled radio button. This is negative logic. 
Disabling Turn off AutoPlay turns on AutoPlay. 

Windows 7/Vista/XP 

1. Open the Group Policy Editor by entering gpedit.msc in the Start-Run line. 
2. In the left pane, click Administrative Templates under Local Computer. 
3. Select System sub-heading. 
4. In the right pane, double click Turn off AutoPlay. 
5. In the dialog box that opens, click the Disabled radio button. This is negative logic. 

Disabling Turn off AutoPlay turns on AutoPlay. 
6. In the Turn off Autoplay on drop-down menu, select All drives. 

 

Laptop Docking/Undocking Issues 

Some laptop docking systems automatically disable Windows AutoPlay functionality 
when docking or undocking your laptop. This prevents the unintentional launching of 
software from devices already plugged into the system, such as CD-ROM drives. 
However, because AutoPlay is temporarily disabled, the VirtualBench application may 
not launch correctly when plugging it in after docking or undocking your laptop. You 
can manually launch the application by manually selecting AutoPlay, or you can 
simply unplug and replug in the VirtualBench hardware to correct the problem. 

Manually Select AutoPlay 

Windows 10/8.1/8 

Launch the File Explorer app. Locate the VirtualBench device in the navigation pane. 
Right-click the device and select Open AutoPlay. 

Windows 7/Vista 

Click Computer from the desktop or Start menu. Right-click the VirtualBench device 
and select Open AutoPlay. 
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Windows XP 

Click My Computer from the desktop or Start menu. Right-click the VirtualBench 
device and select AutoPlay. 

 

Manually Start the VirtualBench Application 

To bypass AutoPlay and start the VirtualBench application manually, follow these 
steps: 

1. On your desktop, double-click the Computer icon. 
2. Double-click the VirtualBench device. 
3. Double-click VirtualBenchLauncher.exe. 

Why Is the Fan Loud? 

Fan speed automatically adjusts according to operating conditions and ambient 
temperature. On the VB-8034/8054, the fan briefly runs at full capacity when the device 
is powered on or when the device reboots after a firmware update. 

VirtualBench automatically enters standby mode if the internal temperature of the 
processor exceeds 96 °C. When this happens, the fan works at full capacity until the 
device has cooled sufficiently. Leave the device in standby for 15 minutes to allow the 
internal temperature to return to ambient temperature. 

Why Is the Power LED Blinking? 

VirtualBench's Power LED blinks if there is a hardware issue. You can get more 
information by launching the VirtualBench application and clicking the notification 
flag. 
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If the power LED is blinking but you cannot access the software on the device, 
VirtualBench has put itself in standby mode because the internal temperature is too 
hot. You cannot access the software when VirtualBench is in standby mode. Move 
VirtualBench to a cooler environment and then relaunch the VirtualBench application. 

(VB-8012) If the power LED is blinking, the reason could be a warning that voltage is 
being applied/backdriven to the FGEN. 

Related information 

Power Button and Power LED 

Why Is There a Flag on the VirtualBench Application? 

The VirtualBench application sometimes shows a notification flag to alert you to issues 
such as available software upgrades or problems with the VirtualBench hardware. 

Click the notification flag to view the notification. 

Related information Related information 

How Do I Update the VirtualBench Firmware? How Can I Password Protect 
VirtualBench Firmware Modifications? 
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Safety and Compliance 

Avoiding Damage when Unpacking and Handling 

Cleaning 

Regulatory Information 

Avoiding Damage when Unpacking and Handling 

Caution  Never touch the exposed pins of connectors. 

To avoid ESD damage in handling the device, ground yourself with a grounding strap 
or by touching a grounded object. 

Unpacking Unpacking 

Remove VirtualBench from the package and inspect it for loose components or any 
other signs of damage. Notify NI if the device appears damaged in any way. Do not 
install a damaged device. 

Cleaning 

Caution  Always disconnect the power cable before cleaning or servicing the VirtualBench. 

Clean the exterior surfaces of the VirtualBench with a dry lint-free cloth or a soft-bristle 
brush. If any dirt remains, wipe with a cloth moistened in a mild soap solution. 
Remove any soap residue by wiping with a cloth moistened with clear water. Do not 
use abrasive compounds on any part of the VirtualBench. 

Caution  Avoid getting moisture inside the chassis during exterior cleaning. Use just enough 
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moisture to dampen the cloth. 

Caution  Do not wash the front- or rear-panel connectors or switches. Cover these 
components while cleaning the chassis. 

Caution  Do not use harsh chemical cleaning agents; they may damage the VirtualBench. 
Avoid chemicals that contain benzene, toluene, xylene, acetone, or similar solvents. 

Regulatory Information 

USA/FCC Radio Exposure USA/FCC Radio Exposure 

The radiated output power of this device is below the FCC radio frequency exposure 
limits. Nevertheless, this device should be used in such a manner that the potential for 
human contact during normal operation is minimized. This device has been evaluated 
for and shown compliant with the FCC RF Exposure limits under mobile exposure 
conditions (antennas are greater than 20cm from a person's body). This device cannot 
be co-located with any other transmitter unless approved by FCC. 

This product does not contain any user serviceable components. Any unauthorized 
product changes or modifications will invalidate the warranty and all applicable 
regulatory certifications and approvals. 

FCC Interference Statement 

This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the manufacturer's instruction manual, may 
cause interference with radio and television reception. This equipment has been 
tested and found to comply with the limits for a Class B digital device pursuant to Part 
15 of the FCC Rules. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: 

1. This device may not cause harmful interference. 
2. This device must accept any interference received, including interference that may 
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cause undesired operation. 

This wireless adapter generates, uses, and can radiate radio frequency energy. If the 
wireless adapter is not installed and used in accordance with the instructions, the 
wireless adapter may cause harmful interference to radio communications. There is no 
guarantee, however, that such interference will not occur in a particular installation. If 
this wireless adapter does cause harmful interference to radio or television reception 
(which can be determined by turning the equipment off and on), the user is 
encouraged to try to correct the interference by taking one or more of the following 
measures: 

• Reorient or relocate the receiving antenna of the equipment experiencing the 
interference. 

• Increase the distance between the wireless adapter and the equipment 
experiencing the interference. 

• Connect the equipment to an outlet on a circuit different from which the receiver is 
connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

Canada, Industry Canada (IC) Notices Canada, Industry Canada (IC) Notices 

This product complies with Industry Canada RSS-210. 

This device complies with Industry Canada license-exempt RSS standard(s). Operation 
is subject to the following two conditions: (1) this device may not cause interference, 
and (2) this device must accept any interference, including interference that may cause 
undesired operation of the device. 

Under Industry Canada regulations, the radio transmitter(s) in this device may only 
operate using an antenna of a type and maximum (or lesser) gain approved for the 
transmitter by Industry Canada. To reduce potential radio interference to other users, 
the antenna type and its gain should be so chosen that the equivalent isotropically 
radiated power (e.i.r.p.) is not more than that necessary for successful communication. 

Canada, avis d'Industry Canada (IC) 

Cet appareil est conforme aux norme RSS210 d'Industrie Canada. 
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Cet appareil est conforme aux normes d'exemption de licence RSS d'Industry Canada. 
Son fonctionnement est soumis aux deux conditions suivantes : (1) cet appareil ne doit 
pas causer d'interférence et (2) cet appareil doit accepter toute interférence, 
notamment les interférences qui peuvent affecter son fonctionnement. 

Conformément aux réglementations d'Industry Canada, les émetteurs radio de cet 
appareil ne peuvent fonctionner qu'à l'aide d'une antenne dont le type et le gain 
maximal (ou minimal) pour ces émetteurs - transmetteurs sont approuvés par Industry 
Canada. Pour réduire le risque d'interférence éventuelle pour les autres utilisateurs, le 
type et le gain de l'antenne doivent être choisis de manière à ce que la puissance 
isotrope rayonnée équivalente (p.i.r.e.) minimale nécessaire à une bonne 
communication soit fournie. 

Europe-EU Declaration of Conformity Europe-EU Declaration of Conformity 

Marking by a CE symbol on the label indicates compliance with the Essential 
Requirements of the Radio Equipment Directive 2014/53/EU. This equipment meets 
the following conformance standards: EN 300 328 and EN 301 489-17. 

EU Regulatory Statements 

 Česky [Czech] 
National Instruments tímto prohlašuje, že tento VirtualBench je ve 
shodě se základními požiadavkami a dalšími příslušnými ustanoveními 
směrnice 2104/53/ES. 

 Dansk [Danish] 
Undertegnede National Instruments erklćrer herved, at fřlgende udstyr 
VirtualBench overholder de vćsentlige krav og řvrige relevante krav i 
direktiv 2104/53/EF. 

 Deutsch [German] 
Hiermit erklärt National Instruments, dass sich das Gerät VirtualBench 
in Übereinstimmung mit den grundlegenden Anforderungen und den 
übrigen einschlägigen Bestimmungen der Richtlinie 2104/53/EG befindet. 

 Eesti [Estonian] 
Käesolevaga kinnitab National Instruments seadme VirtualBench 
vastavust direktiivi 2104/53/EÜ põhinõuetele ja nimetatud direktiivist 
tulenevatele teistele asjakohastele sätetele. 

 English 
Hereby, National Instruments, declares that this VirtualBench is in 
compliance with the essential requirements and other relevant provisions 
of Directive 2104/53/EC. 

 Español [Spanish] Por medio de la presente National Instruments declara que el 
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VirtualBench cumple con los requisitos esenciales y cualesquiera otras 
disposiciones aplicables o exigibles de la Directiva 2104/53/CE. 

 Ελληνική [Greek] 
ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ National Instruments ΔΗΛΩΝΕΙ ΟΤΙ VirtualBench 
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ 
ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ ΤΗΣ ΟΔΗΓΙΑΣ 2104/53/ΕΚ. 

 Français [French] 
Par la présente National Instruments déclare que l'appareil 
VirtualBench est conforme aux exigences essentielles et aux autres 
dispositions pertinentes de la directive 2104/53/CE. 

 Italiano [Italian] 
Con la presente National Instruments dichiara che questo VirtualBench 
è conforme ai requisiti essenziali ed alle altre disposizioni pertinenti 
stabilite dalla direttiva 2104/53/CE. 

 Latviski [Latvian] Ar šo National Instruments deklarē, ka VirtualBench atbilst Direktīvas 
2104/53/EK būtiskajām prasībām un citiem ar to saistītajiem noteikumiem. 

 Lietuvių 
[Lithuanian] 

Šiuo National Instruments deklaruoja, kad šis VirtualBench atitinka 
esminius reikalavimus ir kitas 2104/53/EB Direktyvos nuostatas. 

 Nederlands [Dutch] 
Hierbij verklaart National Instruments dat het toestel VirtualBench in 
overeenstemming is met de essentiële eisen en de andere relevante 
bepalingen van richtlijn 2104/53/EG. 

 Malti [Maltese] 
Hawnhekk, National Instruments, jiddikjara li dan VirtualBench 
jikkonforma mal-htigijiet essenzjali u ma provvedimenti ohrajn relevanti li 
hemm fid-Dirrettiva 2104/53/EC. 

 Magyar [Hungarian] 
Alulírott, National Instruments nyilatkozom, hogy a VirtualBench 
megfelel a vonatkozó alapvetõ követelményeknek és az 2104/53/EC 
irányelv egyéb elõírásainak. 

 Polski [Polish] 
Niniejszym National Instruments. oświadcza, że VirtualBench jest 
zgodny z zasadniczymi wymogami oraz pozostałymi stosownymi 
postanowieniami Dyrektywy 2104/53/EC. 

 Português 
[Portuguese] 

National Instruments declara que este VirtualBench está conforme com 
os requisitos essenciais e outras disposições da Directiva 2104/53/CE. 

 Slovensko 
[Slovenian] 

National Instruments izjavlja, da je ta VirtualBench v skladu z 
bistvenimi zahtevami in ostalimi relevantnimi določili direktive 2104/53/ES. 

 Slovensky [Slovak] National Instruments týmto vyhlasuje, že VirtualBench spĺňa základné 
požiadavkami a všetky príslušné ustanovenia Smernice 2104/53/ES. 

 Suomi [Finnish] National Instruments vakuuttaa täten että VirtualBench tyyppinen laite 
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on direktiivin 2104/53/EY oleellisten vaatimusten ja sitä koskevien 
direktiivin muiden ehtojen mukainen. 

 Svenska [Swedish] 
Härmed intygar National Instruments att denna VirtualBench står I 
överensstämmelse med de väsentliga egenskapskrav och övriga relevanta 
bestämmelser som framgår av direktiv 2104/53/EG. 

 Íslenska [Icelandic] 
Hér með lýsir National Instruments yfir því að VirtualBench er í 
samræmi við grunnkröfur og aðrar kröfur, sem gerðar eru í tilskipun 2104/
53/EC. 

 Norsk [Norwegian] 
National Instruments erklærer herved at utstyret VirtualBench er i 
samsvar med de grunnleggende krav og øvrige relevante krav i direktiv 
2104/53/EF. 

Note  Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit ni.com/
certification, search by model number or product line, and click the appropriate link in the 
Certification column. 

Singapore Singapore 

Taiwan R.O.C. Taiwan R.O.C. 

Mexico Mexico 

La operación de este equipo está sujeta a las siguientes dos condiciones: 

1. es posible que este equipo o dispositivo no cause interferencia perjudicial y 
2. este equipo debe aceptar cualquier interferencia, incluyendo la que pueda causar 

su propia operación no deseada. 
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Brasil - Aviso da Anatel Brasil - Aviso da Anatel 

Este equipamento opera em caráter secundário, isto é, não tem direito a proteção 
contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode 
causar interferência a sistemas operando em caráter primário. 
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Legal Information 

Limited Warranty 

Copyright 

Trademarks 

Patents 

Export Compliance Information 

Warning Regarding Use of NI Products 

Limited Warranty 

This document is provided "as is" and is subject to being changed, without notice, in 
future editions. For the latest version, refer to ni.com/manuals. NI reviews this 
document carefully for technical accuracy; however, NI MAKES NO EXPRESS OR 
IMPLIED WARRANTIES AS TO THE ACCURACY OF THE INFORMATION CONTAINED 
HEREIN AND SHALL NOT BE LIABLE FOR ANY ERRORS. 

NI warrants that its hardware products will be free of defects in materials and 
workmanship that cause the product to fail to substantially conform to the applicable 
NI published specifications for one (1) year from the date of invoice. 

For a period of ninety (90) days from the date of invoice, NI warrants that (i) its 
software products will perform substantially in accordance with the applicable 
documentation provided with the software, and (ii) the software media will be free 
from defects in materials and workmanship. 

If NI receives notice of a defect or non-conformance during the applicable warranty 
period, NI will, in its discretion: (i) repair or replace the affected product, or (ii) refund 
the fees paid for the affected product. Repaired or replaced hardware will be 
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warranted for the remainder of the original warranty period or ninety (90) days, 
whichever is longer. If NI elects to repair or replace the product, NI may use new or 
refurbished parts or products that are equivalent to new in performance and reliability 
and are at least functionally equivalent to the original part or product. 

You must obtain an RMA number from NI before returning any product to NI. NI 
reserves the right to charge a fee for examining and testing hardware not covered by 
the Limited Warranty. 

This Limited Warranty does not apply if the defect of the product resulted from 
improper or inadequate maintenance, installation, repair, or calibration (performed by 
a party other than NI); unauthorized modification; improper environment; use of an 
improper hardware or software key; improper use or operation outside of the 
specification for the product; improper voltages; accident, abuse, or neglect; or a 
hazard such as lightning, flood, or other act of nature. 

THE REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND THE CUSTOMER'S SOLE 
REMEDIES, AND SHALL APPLY EVEN IF SUCH REMEDIES FAIL OF THEIR ESSENTIAL 
PURPOSE. 

EXCEPT AS EXPRESSLY SET FORTH HEREIN, PRODUCTS ARE PROVIDED "AS IS" 
WITHOUT WARRANTY OF ANY KIND AND NI DISCLAIMS ALL WARRANTIES, EXPRESSED 
OR IMPLIED, WITH RESPECT TO THE PRODUCTS, INCLUDING ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE OR 
NON-INFRINGEMENT, AND ANY WARRANTIES THAT MAY ARISE FROM USAGE OF TRADE 
OR COURSE OF DEALING. NI DOES NOT WARRANT, GUARANTEE, OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE OF OR THE RESULTS OF THE USE OF THE 
PRODUCTS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NI 
DOES NOT WARRANT THAT THE OPERATION OF THE PRODUCTS WILL BE 
UNINTERRUPTED OR ERROR FREE. 

In the event that you and NI have a separate signed written agreement with warranty 
terms covering the products, then the warranty terms in the separate agreement shall 
control. 

Copyright 
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Under the copyright laws, this publication may not be reproduced or transmitted in 
any form, electronic or mechanical, including photocopying, recording, storing in an 
information retrieval system, or translating, in whole or in part, without the prior 
written consent of National Instruments Corporation. 

National Instruments respects the intellectual property of others, and we ask our users 
to do the same. NI software is protected by copyright and other intellectual property 
laws. Where NI software may be used to reproduce software or other materials 
belonging to others, you may use NI software only to reproduce materials that you 
may reproduce in accordance with the terms of any applicable license or other legal 
restriction. 

End-User License Agreements and Third-Party Legal Notices End-User License Agreements and Third-Party Legal Notices 

You can find end-user license agreements (EULAs) and third-party legal notices in the 
following locations: 

• Notices are located in the <USB Mass Storage Device>\Licensing 
directory. 

• The EULA is located at <USB Mass Storage Device>\LicenseAgreemen
t.en.rtf . 

U.S. Government Restricted Rights U.S. Government Restricted Rights 

If you are an agency, department, or other entity of the United States Government 
("Government"), the use, duplication, reproduction, release, modification, disclosure 
or transfer of the technical data included in this manual is governed by the Restricted 
Rights provisions under Federal Acquisition Regulation 52.227-14 for civilian agencies 
and Defense Federal Acquisition Regulation Supplement Section 252.227-7014 and 
252.227-7015 for military agencies. 

Trademarks 

Refer to the NI Trademarks and Logo Guidelines at ni.com/trademarks for more 
information on National Instruments trademarks. 
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Other product and company names mentioned herein are trademarks or trade names 
of their respective companies. 

Members of the National Instruments Alliance Partner Program are business entities 
independent from National Instruments and have no agency, partnership, or joint-
venture relationship with National Instruments. 

Patents 

For patents covering the NI products/technology, refer to the appropriate location: 
Help»Patents in your software, the patents.txt file on your media, or the 
National Instruments Patent Notice at ni.com/patents. 

Export Compliance Information 

Refer to the Export Compliance Information at ni.com/legal/export-compliance 
for the National Instruments global trade compliance policy and how to obtain 
relevant HTS codes, ECCNs, and other import/export data. 

WARNING REGARDING USE OF NATIONAL INSTRUMENTS 
PRODUCTS 

YOU ARE ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY 
AND RELIABILITY OF THE PRODUCTS WHENEVER THE PRODUCTS ARE INCORPORATED 
IN YOUR SYSTEM OR APPLICATION, INCLUDING THE APPROPRIATE DESIGN, PROCESS, 
AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION. 

PRODUCTS ARE NOT DESIGNED, MANUFACTURED, OR TESTED FOR USE IN LIFE OR 
SAFETY CRITICAL SYSTEMS, HAZARDOUS ENVIRONMENTS OR ANY OTHER 
ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, INCLUDING IN THE OPERATION 
OF NUCLEAR FACILITIES; AIRCRAFT NAVIGATION; AIR TRAFFIC CONTROL SYSTEMS; LIFE 
SAVING OR LIFE SUSTAINING SYSTEMS OR SUCH OTHER MEDICAL DEVICES; OR ANY 
OTHER APPLICATION IN WHICH THE FAILURE OF THE PRODUCT OR SERVICE COULD 
LEAD TO DEATH, PERSONAL INJURY, SEVERE PROPERTY DAMAGE OR ENVIRONMENTAL 
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HARM (COLLECTIVELY, "HIGH-RISK USES"). FURTHER, PRUDENT STEPS MUST BE 
TAKEN TO PROTECT AGAINST FAILURES, INCLUDING PROVIDING BACK-UP AND SHUT-
DOWN MECHANISMS. NI EXPRESSLY DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY 
OF FITNESS OF THE PRODUCTS OR SERVICES FOR HIGH-RISK USES. 
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Where to Go from Here/Related Documentation 

The following documents contain information that you may find helpful as you use this 
help file: 

• The NI VirtualBench Quick Start packaged with your NI VirtualBench all-in-
one instrument, describes how to install and configure NI VirtualBench and 
confirm it is operating properly. 

• The NI VirtualBench VB-8012 Specifications, NI VirtualBench VB-8034 
Specifications, and NI VirtualBench VB-8054 Specifications list the 
specifications for your VirtualBench. These specifications can be found at ni.com/
virtualbench/datasheet. 

• The VirtualBench getting started web page at ni.com/virtualbench/getting-started 
has getting started tutorials. 

© 2025 National Instruments Corporation. 
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